COPYRIGHT NOTICE
This software product and accompanying documentation is copyrighted and all rights reserved by ISI. Please refer to the accompanying Reference Manager Concurrent Network License Agreement for a specification of the terms and conditions governing the use of this product.

RESTRICTED RIGHTS
Use, duplication or disclosure by the government is subject to restrictions as set forth in subparagraph C(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) or (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable. Manufacturer is ISI ResearchSoft, 800 Jones Street, Berkeley, CA 94710, USA.

DISCLAIMER OF WARRANTY
This software and manual are sold “as is” and without warranties as to performance or merchantability. The seller's salespersons may have made statements about this software. Any such statements do not constitute warranties and shall not be relied on by the buyer in deciding whether to purchase this program.

This program (hereafter known as the Product) is sold without any express or implied warranties. Because of the diversity of conditions and hardware under which the Product may be used, no warranty of fitness for a particular purpose is offered. The user is advised to test the Product thoroughly before relying on it, and must assume the entire risk of using the Product. Any liability of seller or manufacturer will be limited exclusively to product replacement or refund of the purchase price. In no event shall ISI ResearchSoft, or anyone else who has been involved in the creation and production of this Product be liable for indirect, special or consequential damages, such as but not limited to, loss of anticipated profits or benefits resulting from the use of this program. Some states do not allow the exclusion or limitation of incidental or consequential damages, so the above limitation may not apply.

TRADEMARKS
Reference Manager is a registered trademark of ISI. Microsoft and Windows are registered trademarks of Microsoft Corporation. All other product names are trademarks or registered trademarks of their respective owners.

Printed in the USA, June 2002
© 2000 ISI
Introduction

This section gives a short description of Reference Manager and the Network Edition specifically.

Reference Manager

Reference Manager for Microsoft® Windows® 2000/98/95 and NT4 is a personal bibliographic reference management system designed to keep track of references in your field of interest.

You can enter over 30 pre-defined reference types, including journals, books, conference proceedings, patents, slides and theses. You can enter references, including notes or comments, in many ways:

- Enter references manually, from the keyboard.
- Follow menus to enter text from lists.
- Quickly search and import references from various web-based libraries around the world with the Internet Search feature.
- Import references from a text file downloaded from an online search service (such as MEDLARS, Dialog, PaperChase or OVID) or a CD-ROM (such as ISI, SilverPlatter, MicroPatent or OVID).
- Automatically incorporate references from a current awareness service, such as Current Contents, Reference Update, or Web of Science (available from ISI).

Once entered, you can retrieve references using the author’s name, a keyword, periodical name, year of publication, word or phrase appearing in the title or notes, reference type, or any other field.

Reference Manager can insert formatted citations in your manuscripts and generate bibliographies formatted in almost any journal style.

The Network Edition

Reference Manager Network Edition allows several users to share a single copy of the Reference Manager application and database files. The Network Edition is sold in a 5-user network pack, which provides five individuals with authorized use of the application. Multiple 5-user packs should be purchased to support additional users. Although only one copy of the software needs to be installed when purchasing multiple 5-packs, you should retain all serial numbers for registration and technical support.
This guide helps network administrators manage a variety of access rights to the Reference Manager databases and identifies the types of rights required to perform specific program functions. Instructions are included for Novell 3.1/4/5, Windows NT 4.0 and Windows 2000 client server configurations, and Win95/98 peer-to-peer configurations.

Individual users can also control access privileges. However, a user’s access can be overridden and limited by the network administrator.

Users of earlier versions of Reference Manager Network Edition can easily upgrade a database to Version 9.5 in the Open Database dialog. Details for conversions are provided in this booklet.
Installing/Uninstalling the Reference Manager Network Edition

The network edition of Reference Manager is licensed for a particular number of users. You can install Reference Manager on a shared network for simultaneous use, or you can install locally for each of the licensed users.

You must run two installation programs to successfully install the Reference Manager Network edition:

• First, a network administrator should install the Reference Manager Network edition from the CD to a network or local hard drive.

• Then, either the administrator or each user must navigate from each local machine to the Reference Manager folder and run the workstation installation.

Hardware and Software Requirements

Reference Manager hardware and software requirements are as follows:

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pentium or better personal computer</td>
<td>Microsoft® Windows® 95 or later, or Windows® NT 4.0 or later</td>
</tr>
<tr>
<td>32 megabytes available memory, minimum</td>
<td>(Optional) Word processing software to cite references in your manuscripts: Microsoft® Word for Windows® Version 7, 97, 2000, or Corel® WordPerfect® Version 7, 8, 9</td>
</tr>
<tr>
<td>25 megabytes available disk space, minimum, plus space for databases</td>
<td>(Optional) Web Browser to Internet Search or use the URL field linking</td>
</tr>
<tr>
<td>CD ROM drive</td>
<td></td>
</tr>
<tr>
<td>Network cards, network connectivity</td>
<td></td>
</tr>
</tbody>
</table>
The amount of hard disk space you need varies according to the size of your database, and the size of your database varies according to the size of your references. If your references contain no notes, or only short notes, each reference is approximately 400 bytes. A database containing 2,000 references, with no notes, occupies approximately one megabyte (1 MB) of hard disk space.

Notes: Since Reference Manager is a Win 32 application, your network must be accessible to systems running Windows NT 4.0, Windows 2000/98/95, or Novell NetWare 3.1/4/5.

The Windows Terminal Server Edition has not been tested or supported for Reference Manager 9.5.

Network Program Installation

This section explains how to install Reference Manager on a network server for access by multiple users or to a local hard disk for a single computer. Reference Manager supports network installation for client-server workgroup configurations as well as peer-to-peer configurations.

The network program installation copies program files, output styles, import filters, and sample databases, but does not install system files or change the registry setting on any machine.

This procedure assumes that you are installing from the CD ROM and that Reference Manager will reside in the folder \Program Files\Reference Manager 9 Network on your drive.

Existing Reference Manager Users: If you previously installed the Reference Manager Network Edition version 7 or 8.x, you must install version 9.5 in a new folder. Do not install this version into the existing Reference Manager folder. Database conversion information appears later in this guide.

You can install Reference Manager Network Edition version 9.5 directly over version 9.

Back up custom files before you begin installing! Don’t take the chance of overwriting edited Output Styles or Capture Definitions!
To install the Reference Manager program:

1. Close all other programs, including the Microsoft Office Shortcut Bar and/or any anti-virus or crash guard programs.

2. Put the Reference Manager 9.5 Network CD in your CD-ROM drive and click Install.

3. On the Welcome dialog, click Next.

4. Click Next to accept the license agreement.

5. Click Next to accept the default installation folder (recommended): /Program Files/Reference Manager 9 Network/

   Or, if you want to change the installation folder, click Browse, locate a new folder, and click Next.

6. Accept the default program group where Reference Manager administrator icons may be added, or select a different program group. Click Next.

7. Enter registration information and click Next. While this information is optional, entering it here will make it easier to find later.

8. Click Next to begin installing the program.

9. When the program installation is done, you can select from these options and click Finish:

   • Register Online: Select this option to go online and send registration information directly to ISI ResearchSoft.

   • Configure Concurrent Metering Utility:

   Note: The Concurrent Metering Utility is available for customers that purchased a Concurrent Use license and do not plan to use a third party metering program. If you purchased a User License, do not select this option.

To configure the Concurrent Metering Utility:
a. Select **Enforce number of concurrent users limit**.

b. Type in the **Licensed number of concurrent users**. This information is found on your license agreement addendum. The minimum number is five.

c. Enter the **Concurrent user count file path**. This determines where a Winrm9n.knw file is created. This file keeps track of the number of users, and is created when you leave this dialog.

   Use the browse button to find and select the correct path. Typically, this will be the Reference Manager program folder. For example:

   `\Servername\Program Files\Reference Manager 9 Network\`

   **Note:** All users must have full read, write, and execute access to this path.

d. Click **OK**.

Next you need to install certain system files and word processor files on individual user machines as described in the next section.

**Note:** Even if you have installed the Reference Manager Network Edition on a local computer, you must also run the workstation installation on that machine.

### Workstation Installation

Once you have installed or upgraded the Reference Manager Network Edition on your network or local hard drive, you (or each user) must run the workstation installation on each computer that will access Reference
Reference Manager. If you have loaded Reference Manager on a local hard drive, run the workstation installation program on this computer as well.

This updates system files as needed, updates the Windows registration database as needed, adds word processor support for *cite while you write*, and adds shortcuts to the **Start** menu.

**Notes:** The installation must be run under an account that has administrator rights. To properly copy workstation files in Windows 2000/NT, the User of the workstation must be given temporary administrator rights to perform the installation.

You need full access (read and write privileges) to Microsoft Word’s Startup folder to install *cite while you write* support for Word.

**To install system and optional word processor files on individual user machines:**

1. Close all other programs, including the Microsoft Office Shortcut Bar and/or any anti-virus or crash guard programs.
2. From the local machine, use Windows Explorer to go to the Reference Manager 9 Network\Program folder.
3. Double click the InstRM9W.exe file and follow the instructions.

**Note:** The InstRM9W.exe must be in the Program folder to work.

During the workstation installation, select a program group to add shortcuts to the **Start** menu.

Under the **Start** menu, under **Programs**, the installation program adds a **Reference Manager 9** shortcut menu.
Cite While You Write Installation

In most cases, running the Workstation Installation automatically installs word processor support for cite while you write (CWYW). However, in these instances you may need to specifically install support:

- Some word processor versions (Word 2000, WordPerfect versions) may require configuration on a per user basis—even when users are working from the same workstation.

  If you have run the Workstation Installation and Reference Manager commands are not available on the Tools menu in your word processor, install CWYW support separately on a per user basis.

- If you install a new word processor after installing Reference Manager, install CWYW support.

Notes: You need full access (read and write privileges) to Microsoft Word’s Startup folder in order to install cite while you write support for Word.

To install CWYW support:

From the Start menu, select Programs, Reference Manager 9, then Install CWYW.

The CWYW Setup.exe program is in the Reference Manager program folder, and can also be run directly from that location.

Starting Reference Manager

To start using Reference Manager, go to the Start menu, select Programs, Reference Manager 9, and then Reference Manager 9 Network.
Uninstalling Reference Manager

Before uninstalling Reference Manager, back up any files you wish to keep.

For network installations, remove Reference Manager files from individual workstations first. Then remove the Reference Manager program from a shared server.

To remove Reference Manager 9.5:
1. From the Start menu, choose Settings, then Control Panel.
2. Double-click Add/Remove Programs.
3. Remove first the RM9 Workstation program and then the RM9 Network program.
   • For local hard disk installations, remove both files.
   • For network installations, remove the RM9 Workstation program from individual machines. Then, from the shared server, remove the RM9 Workstation program (if it exists there) and the RM9 Network program.
Setting Access Privileges

Reference Manager Network Edition gives the network administrator the ability to grant users full read/write access or read-only access. By default, the program installation gives all users full read/write access to all files.

On a secondary level, each user that has full read/write access can control database access privileges.

Network Administrator: Setting Access Privileges

The network administrator can grant users full read/write access or read-only access. Immediately after installation of Reference Manager, all users have full read/write share access to all files.

Note: If you want to limit access, we recommend that you grant rights on a user-by-user basis or on a group basis. If you mix user rights within the groups, verify that the rights on each inherited level are correct.

Using the RMACCESS Folder to Restrict Privileges

Note: The RMACCESS folder is not needed or used in an NT Server 4 (FAT) or Windows 95/98 Peer-to-Peer environment.

When installed, Reference Manager creates a Database folder in the Reference Manager program path. The Database folder includes both a sample database and an empty RMACCESS folder:

X:\Program Files\Reference Manager 9\Database\RMACCESS
X:\Program Files\Reference Manager 9\Database\Sample.rmd
X:\Program Files\Reference Manager 9\Database\Sample.rmx

The administrator should use the network server’s administration utility to assign rights to the RMACCESS folder. By restricting access to the RMACCESS folder, you restrict a user’s access to all databases in the same folder. In the above example, rights assigned to the RMACCESS folder affect the Sample database (and any other database later stored in the same folder). Please note that the Sample database is not in the RMACCESS folder; it is stored in the same folder as the empty RMACCESS folder.

For each database folder, you may want to create another RMACCESS folder to assign a variety of user rights.
**Note**: There are no restrictions as to where databases reside; you can place them in any network folder or local drive and folder. Remember, however, to create and use the RMACCESS folder, or all users will have full read/write access.

**Network Access Rights**

Within the Reference Manager program folder is a Database folder. To restrict access rights, the network administrator should use the RMACCESS folder as described in the previous section.

**Note**: If the network administrator intends to give full read and write access to all users, it is not necessary to use the RMACCESS folder to designate specific access rights.

The following table describes how to establish access rights for certain Reference Manager folders under different operating systems:

- Windows 98/Windows 95 Peer-to-Peer
- NT Server 4.0 (FAT) Server/Workstation
- NT Server 4.0/Windows 2000 (NTFS) Server/Workstation
- Novell Netware 3.1x/4.xx/5.xx

**Note**: The default folder for the Winrm9n.knw file, which tracks concurrent metering, is the program folder. If you are using the Concurrent Metering Utility, you must allow full access to this folder.

**Windows 98/Windows 95 Peer-to-Peer**

A peer-to-peer configuration does not allow you to set access rights for various folders. If you are using Windows 98/95 with Novell Netware, please see that section on page 13.

**NT Server 4.0 (FAT) Server/Workstation**

An NT Server 4.0 (FAT) Server/Workstation configuration does not allow you to set access rights for various folders. Permissions can be applied only to the share point.
### Program Folder

<table>
<thead>
<tr>
<th>For this access</th>
<th>Set these rights</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full access</td>
<td>Sharing\Permission\Full Control</td>
</tr>
<tr>
<td></td>
<td>Security\Permission\Full Control</td>
</tr>
<tr>
<td>Read, write, prevent file deletion yet allow modifications to the Periodical Term Dictionary</td>
<td>Sharing\Permission\Full Control</td>
</tr>
<tr>
<td></td>
<td>Security\Permission-Special File Access - Read, Write, Execute</td>
</tr>
<tr>
<td>Read-only. Prevent file deletion or modification; prevent modifying the Periodical Word Dictionary</td>
<td>Security\Permission\Special File Access - Read, Execute</td>
</tr>
</tbody>
</table>

### Import Filters and Output Styles Folders

<table>
<thead>
<tr>
<th>For this access</th>
<th>Set these rights</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full access</td>
<td>Sharing\Permission\Full Control</td>
</tr>
<tr>
<td></td>
<td>Security\Permission\Full Control</td>
</tr>
<tr>
<td>Read, edit, or create files but prevent file deletion</td>
<td>Sharing\Permission\Full Control</td>
</tr>
<tr>
<td></td>
<td>Security\Permission\Special File Access - Read, Write</td>
</tr>
<tr>
<td>Read-only. Prevent creation or modification of files</td>
<td>Sharing\Permission\Full Control</td>
</tr>
<tr>
<td></td>
<td>Security\Permission\Special File Access - Read</td>
</tr>
</tbody>
</table>

### Database Folder

<table>
<thead>
<tr>
<th>For this access</th>
<th>Set these rights</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full access</td>
<td>Sharing\Permission\Full Control</td>
</tr>
<tr>
<td></td>
<td>Security\Permission\Special File Access - Read, Write, Delete</td>
</tr>
<tr>
<td>Prevent deletion of database files</td>
<td>Sharing\Permission\Full Control</td>
</tr>
<tr>
<td></td>
<td>Security\Permission\Special File Access - Read, Write, Execute</td>
</tr>
</tbody>
</table>
### RMACCESS Folder

<table>
<thead>
<tr>
<th>For this access</th>
<th>Set these rights</th>
</tr>
</thead>
</table>
| Full access       | Sharing\Permission\Full Control
                      | Security\Permission\Special File Access - Read, Write, Delete                     |
| Read-only         | Sharing\Permission\Full Control
                      | Security\Permission\Special File Access - Read                                    |

### Novell Netware 3.1x/4.xx/5.xx

#### Program Folder

<table>
<thead>
<tr>
<th>For this access</th>
<th>Set these rights</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full access</td>
<td>Read, Write, Create, Erase, File Scan</td>
</tr>
<tr>
<td>Read, write, prevent file deletion yet allow modifications to the Periodical Term Dictionary</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Read, Write, File Scan</td>
</tr>
<tr>
<td>Read-only, prevent file deletion or modification</td>
<td>Read, File Scan</td>
</tr>
</tbody>
</table>

#### Import Filters and Output Styles Folders

<table>
<thead>
<tr>
<th>For this access</th>
<th>Set these rights</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full access</td>
<td>Read, Write, Create, Erase, File Scan</td>
</tr>
<tr>
<td>Read, edit, or create files but prevent file deletion</td>
<td>Read, Write, Create, File Scan</td>
</tr>
<tr>
<td>Read definitions only</td>
<td>Read, File Scan</td>
</tr>
</tbody>
</table>

#### Database Folder

<table>
<thead>
<tr>
<th>For this access</th>
<th>Set these rights</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full access</td>
<td>Read, Write, Create, Erase, File Scan</td>
</tr>
</tbody>
</table>
Prevent database deletion | Read, Write, Create, File Scan

<table>
<thead>
<tr>
<th>RMACCESS Folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>For this access</td>
</tr>
<tr>
<td>Full access</td>
</tr>
<tr>
<td>Read-only</td>
</tr>
</tbody>
</table>

User-defined Access Settings

By default, every user has full access unless specifically restricted by the network administrator with the RMACCESS folder. Then, on a local level, each user can control access to individual databases by selecting **Open Database** from the **File** menu. Under **Access rights**, select Read/Write Share, Read-Only Share, or Read/Write Exclusive.

**Note:** If the network administrator restricts a user to Read-Only access, the user cannot open the database with Read/Write Share or Read/Write Exclusive access. If the network administrator gives full access, the user has the option of opening the database in any of the three modes: Read/Write Share, Read-Only, or Read/Write Exclusive.

**Read/Write Share:** Users have simultaneous access to all database functions (except Global Edit and Field and Type Edit). Performing batch functions, such as Batch Duplicate Check, in this mode may slow down other workstations accessing the database.
**Read-Only Share:** Multiple users can simultaneously perform functions that do not write to the database. Users cannot edit, add a new reference, delete a reference, import, scan for keywords, or use the URL feature.

**Read/Write Exclusive:** This prevents other users from accessing the database until it is closed. Use this mode to perform global edits and all batch functions. Read-Write Exclusive allows the user to add synonyms by activating Term Manager and to select Field and Type Edit from the Tools menu.

---

**Note:** Use Read/Write Exclusive access to perform global edits and all batch functions. Remember that when you open a database in Read/Write Exclusive mode, no other user can open the database until you close it.
Allowing Internet Searching

Reference Manager allows users to search PubMed and hundreds of Z39.50 compliant libraries worldwide. In order to do so, you may need to allow access through firewalls, including proxy servers.

See “Chapter 9: Retrieving References and Saving Retrieval Strategies” in the Reference Manager User’s Guide for more information about allowing access through firewalls and proxy servers, plus how to determine which port is used by a particular library.

**Note:** PubMed uses port 80, the Library of Congress uses port 7090, and many other libraries use port 210.

Concurrent Metering

The Concurrent Metering Utility is available for customers that purchased a Concurrent Use license. If you do not have a third party metering program, you can use this utility to restrict access to the licensed number of users. The utility is installed and initially set up during installation of Reference Manager Network Edition. Settings are stored in the Winrm9n.knw file.

**Note:** Only the network administrator can run the Concurrent Metering Utility. It does not appear on individual workstations’ **Start** menus, and the NetCount.exe file cannot be run by double-clicking it in the program folder.
Recovering from a Crash

If Reference Manager terminates abnormally, the concurrent metering utility is interrupted. You will need to clear metering.

To clear concurrent metering after a crash:

1. Start the Concurrent Metering Utility using one of these methods:
   - From the Start menu (on a Windows NT server), select Programs, Reference Manager 9, and then Concurrent Metering Utility.
   - From a workstation, create a shortcut for NetCount.exe and right-click Properties to modify the shortcut Target field. Add after the path (without the quotes):
     “/ADMINMODE winrm9n.exe”
     For example:
     \Server\Share\Programs\Reference Manager 9 Network\Program\NetCount.exe /ADMINMODE winrm9n.exe
     In some situations, your path may include quotes, as in:
     “C:\Programs\Reference Manager 9 Network\Program \NetCount.exe” /ADMINMODE winrm9n.exe
   - For a command line prompt, type in the full path to NetCount.exe and add (without the quotes):
     “/ADMINMODE winrm9n.exe”

2. Click Clear, make sure the other settings are correct, and then click OK to exit.

Modifying the Number of Licensed Users

You may need to modify the number of concurrent users allowed access to Reference Manager. For instance, if you purchase additional licenses for concurrent use of Reference Manager, you need to increase the number of allowed users in the Concurrent Metering Utility.
To change the number of concurrent users allowed access to Reference Manager:

1. Start the Concurrent Metering Utility using one of these methods:
   - From the Start menu (on a Windows NT server), select Programs, Reference Manager 9, and then Concurrent Metering Utility.
   - From a workstation, create a shortcut for NetCount.exe and right-click Properties to modify the shortcut Target field. Add after the path (without the quotes):
     ```
     /ADMINMODE winrm9n.exe
     ```
     For example:
     ```
     \Server\Share\Programs\Reference Manager 9 Network\Program\NetCount.exe /ADMINMODE winrm9n.exe
     ```
     In some situations, your path may include quotes, as in:
     ```
     "C:\Programs\Reference Manager 9 Network\Program\NetCount.exe" /ADMINMODE winrm9n.exe
     ```
   - For a command line prompt, type in the full path to NetCount.exe and add (without the quotes):
     ```
     /ADMINMODE winrm9n.exe
     ```

2. Enter the new Licensed number of concurrent users and click OK.
Custom User Settings/Sharing Files

Each user can customize database settings that affect certain functions in Reference Manager: General, Retrieval, Import, Reference Edit, Duplicate Search, and Internet Search.

To personalize individual user settings:
1. From the Tools menu, select Options.
2. Customize the settings in each tab.
3. Click OK.

These settings are unique for each workstation and are stored locally with your Windows default settings.

For more information about these settings, see “Customizing Reference Manager” in Chapter 12 of the Reference Manager User’s Guide.

Assigning Reference IDs

Each user can customize how reference IDs are assigned to new records—numerically or by author/date. However, we recommend that users determine one form to use for shared databases. If users are inconsistent in assigning IDs, the database will have a combination of numeric IDs and author/date IDs.

To set the reference ID assignment mode:
1. On the Options dialog, select the Reference Edit tab.
2. Select Assign Reference ID.
3. Under Reference ID Assignment Mode, select either Numeric or Authors, primary + Date, primary for the ID format.
4. When you enter a new reference, the selected form is used for the new reference ID.

Storing Custom Files

If users create or edit Import Filters or Output Styles, we recommend that they save them to their personal computers or personal folders and not a network shared area. The network administrator may have given other users write access to the network shared area, which means they could make changes to files. For clarity, it is best to save edited files with a different name.
Search strategies, reference indexes, the phrase list dictionary, and the workstation installation log are stored locally as application data, so you don’t have to worry about other users making modifications.
Upgrading Databases from Earlier Versions

As the network administrator, you may need to update Reference Manager databases shared on a server.

- **Version 9 databases:**
  The database is directly compatible; no conversion is necessary. Simply open the database with Reference Manager 9.5.

- **Version 8.x databases:**
  Open the database with Reference Manager 9.5. You will be asked whether to open the database read-only or convert it to version 9.5. Click Convert and Reference Manager updates the database.

- **Version 5, 6, or 7 databases:**
  Follow the procedure below to convert the database to a new version 9.5 database.

- **Version 4 databases:**
  Contact ISI ResearchSoft technical support for a free conversion utility.

When you convert a Reference Manager version 5, 6, or 7 database, the existing database is unchanged and a new version 9.5 database is created with the name and in the location you specify.

**To convert a database created with Reference Manager version 5, 6, or 7 to version 9.5:**

1. Close all other programs, including the Microsoft Office Shortcut Bar and/or any anti-virus or crash guard programs
2. From the File menu, choose Open Database.
3. Under Files of Type, select RM 5/6/7 databases (refman1.dat). Locate the version 5, 6, or 7 database and click Open.
4. Click Convert to Version 9.5. The dialog displays the Source Database name and path for the old database.
5. In the Destination Database box, enter the complete path and database name for the version 9.5 database you want to create from the old database.

You can manually type the full path or navigate to the desired location with the browse button.

In the New Reference Manager Database dialog, select the path and enter the name of the new database. A suggested database name appears that is based on the database you are converting. Do not add a file extension, as Reference Manager appends the appropriate extensions. Click New to create the new database and return to the Database Conversion dialog.
6. If you want to copy the database definition from your old database, select **Copy Database Definition**. The database definition includes the reference types and fields you have defined.

7. If you want to copy the periodical synonyms from your old database, select **Copy Periodical Synonyms**.

8. To change the sort order of the references, click **Database Sort Order** to make the changes and then click **OK**.

9. Click **Convert** to begin copying your version 5, 6, or 7 database to the Version 9.5 database format.
New Features in Version 9.5

Reference Manager Version 9.5 includes the following new features and enhancements.

Search ISI

- The new Search ISI feature in Reference Manager puts an entire research library right at your fingertips. Whether your field of study is in the sciences, social sciences, or humanities, the Search ISI command opens the door to access more than one million entries from over 9000 scholarly publications. Unique inter-linking of articles, bibliographies, and authors, as well as online document ordering makes this system an invaluable tool for the research process. See the Reference Manager help file for details.

Updates to Z39.50 Host Configurations and Retrieval

- The Z39.50 Internet search feature was rewritten to ensure accurate retrievals.
- The Z39.50 Internet search feature now supports UNImarc, Ukmarc, CANmarc, GRS-1 and SUTRS formats.
- Bkwr.api, a new subfolder of the Reference Manager program folder, contains filters for use with the Z39.50 search feature. These filters import data from various sites into specific Reference Manager fields. You can customize filters with the Import Filter Editor to resolve data mapping issues.
- Proxy server support has been added. If your institution uses a proxy server, go to the Configure Hosts dialog and click the Proxy Server button to add the necessary settings.
- From the Internet Retrieval window, the Field selection popup list includes only fields that are supported by all selected databases. This ensures valid searching of the selected databases.
- Field names in the Field selection popup list are editable in the Configure Hosts|Properties dialog. We have also added Boolean (logical) connectors within the field names, if applicable.
- An Internet Search Status Message Log now displays at the end of every search. You can view any connection or database host messages and the actual data that is being retrieved. The dialog contains a drop
down menu that allows selection of either the status messages or the record data view, and appears after both PubMed and Z39.50 Internet searches.

- We removed databases that either were not performing correctly or for which we did not have specifications. There are currently 195 remote databases configured for access. (Some databases are hosted by services that require a valid username and password.)

**Search Using the PubMed Unique Identifier**

- Use a PubMed Unique Identifier (UI) to search and find a record on PubMed.
- Enter the PubMed UI in the Web/URLs field of your Reference Manager reference and click on the web icon to launch your Internet browser and locate the PubMed record.

**Output Style Additions and Modifications**

- We added hundreds of new output styles, bringing the total to well over 670.
- Existing output styles have been edited for changes or corrections.
- Author name formatting options were added to the output style editor. Specifically, you can now choose “Lastname,F.S” or “Lastname,

**International Support for Sorting**

- These languages have been added to the list of supported languages when sorting a database:
  - Czech
  - Polish
  - Russian (Cyrillic)

  From the Tools menu, select Change Database Sort and locate the Text Sort box. Select the International Word Sort radio button to allow selection of the new sorts.
Frequently-Asked Questions

This section describes some of the more common situations that might arise and their solutions.

**Why is the Field and Type Editor not available?**

The database was not opened with read-write exclusive access. Close the database and reopen it with the File, Open Database command. In the Open Database dialog, select Read-Write Exclusive in the Access rights box. Nobody else will be able to access the database while it is opened with Read-Write Exclusive access.

**Why can’t I perform global edits or other batch functions?**

The database was not opened with read-write exclusive access. Close the database and reopen it with the File, Open Database command. In the Open Database dialog, select Read-Write Exclusive in the Access rights box. Nobody else will be able to access the database while it is opened with Read-Write Exclusive access.

**I followed the instructions for setting a database for Read-Only, but I can open it in Read-Write. Why?**

The most common reason for this is that the user’s login rights to the RMACCESS folder are inheriting the write attribute. When you limit access to a database, you should grant rights on a user-by-user basis or on a group basis. If you mix user rights within groups, verify that the rights on each inherited level are correct.

In some cases, moving the RMACCESS folder to the root of the drive where the program is installed and creating a shortcut from the database folder to the new RMACCESS location will resolve this issue.

**Reference Manager says, “Cannot open Database.” Why can’t I open the database?**

Most likely, someone else already has the database open with Read-Write Exclusive access. The database is not available to anyone else until that user closes it.

It is possible that the user doesn’t realize the database was opened with Read-Write Exclusive access. A database is automatically opened with the access used the last time the database was opened by that user. To change the access type, the user must use the File, Open Database command and change the access type in the Access Rights box before opening the database.
I recently edited an output style (or import filter). I used it in the program, and it was not my edited version. Why not?

First, it’s possible that someone overwrote all output styles and/or import filters by installing them again from the CD.

Sets of output styles and import filters are included with the program, and all users of Reference Manager have access these sets. Any user with read/write access can edit output styles and import filters. Changes are implemented immediately and are applied the next time the file is used. To avoid overwriting another user’s changes to output styles or import filters, we recommend that you save edited files under a different name (both the output style or import filter name and the file name).

You can save edited output styles and import filters to a personal folder so others don’t have access. When you use the file later, make sure you select the one in your personal folder (you may need to browse to locate it), and not from the shared folder. For clarity, it is best to save edited files under a different name.

In output styles, all reference types are listed separately. You may need to make modifications for every reference type used in the database. For example, if you make changes to the journal definitions in the output style, your output for a book won’t be affected. Similarly, you may need to make changes for several databases in an import filter.